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Chapter 1.  INTRODUCTION 

Chapter 1-1.  Overview 

This document, HTTPAPI, specifies the HTTP-based application-programming interface (API) for Merit 

LILIN iMegaPro and iMegaLite.  Application developers can use this document to develop applications 

for Merit LILIN’s IP products.  The HTTP-based camera interface provides the functionalities, for 

example, to request video images, to control device outputs (PTZ, output relay etc.), and to get and to 

set IP devices’ information.  

 

Chapter 1.1.  Firmware versions 

The support for this HTTPAPI document is highly dependent on the product release. Please make sure 

that the functions, you want, are provided by the release of your product.   

 

Chapter 1.2.  Product-specific functionality 

Some of the functions described in this specification may not be implemented in every IP-based product, 

and the set of the Common Gateway Interface (CGI) parameters and actual parameter values may differ 

among different products.  At the end of each API function has product information for developers.   

 

Chapter 1.3.  Product Support List 

iMegaPro (Full HD IP Camera Series, 2, 3, and 5 MP): 

  IPR733, IPR434, IPR742, IPR722, IPR320, IPG1022, IPG1032, IPG1052, IPD2122S 

  IPD622, IPD2220, IPR6122, IPD6122, IPD2322  

 

L series (1080P 15FPS or 720P 30FPS): 

  LR742, LR7022, LB1022, LD2222, LR6122, LD2322, LD2122, LR7224, LR7228, LR7722, 

  LR2322 

 

Video Server 

VS212 

 

PTZ  

IPS722 (1.3MP indoor), IPS622 (1.3MP outdoor), IPS926(960H 26X indoor), IPS826(960H 26X 

outdoor), IPS936(960H 36X indoor), IPS836(960H 36X outdoor) 
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Chapter 2.  HOW TO USE THIS MANUAL 

This section contains information about general usages of this document. 

Chapter 2.1.  General notations 

Chapter 2.1.1.  General abbreviations 

CGI : Common Gateway Interface – a standardized way to communicate between a client (e.g., a 

web browser) and a server (e.g., a web server). 

N/A : Not applicable – a feature/parameter/value is not used in a specific task. 

  

Chapter 2.2. Convention of this document 

In URL syntax and in descriptions of CGI parameters, text in italic within angle brackets denotes that is to 

be replaced with either a value or a string. When replacing the text string, the angle brackets shall also 

be replaced.  

 

Chapter 2.3 HTTP status returned codes 

The built-in Web server uses the standard HTTP status codes.  The syntax of returned HTTP status is 

as following format: 

HTTP/1.0 <HTTP code> <HTTP text> \r\n 

HTTP code and text meanings are described as the followings: 

 

HTTP Code HTTP Text Description 

200 OK The request has succeeded. 

204 No Content Server has received the request but there is no information 
returned, and the client should stay in the same document 
view. This is mainly to allow inputting scripts without changing 
the document at the same time. 

400 Bad Request The request had bad syntax or was inherently impossible to be 
satisfied. 

401 Unauthorized The parameter to this message gives a specification of 
authorization schemes that are acceptable. The client should 
retry the request with a suitable Authorization header. 

403 Forbidden The request is for an action that is forbidden. 

404 Not Found The server has not found anything matching the given URL. 
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Chapter 3.  HTTP API       

Chapter 3.1.  Image and video request URLs 

There are two different ways to request images from Merit LILIN’s IP Fast Dome, LAN camera, and 

video server—snapshot (JPEG) and server-push (MJPEG).   

 

Chapter 3.1.1.  JPEG image (snapshot) 

When a jpeg image is requested, the server either returns the specified JPEG image file or an image 

with an error image (No Video | Not Permission | Not available). 

Syntax:  

http://< serverIP >/snap<image size> 

 

Parameter Values Description 

<image size> “cif” 

“480p” 

“720p” 

“1080p” 

352 by 240 

720 by 480 

1280 by 768  

2MP cameras (if JPEG 1080P profile gets opened) 

 

Example: Request JPEG image from video input with 480P size. 

HTTP/1.0 200 OK\r\n 

Content-Type: image/jpeg\r\n 

Content-Length: 8567\r\n 

\r\n 

<JPEG image data which start with 0xffd8 and end with 0xffd9>\r\n 

 

Example: Request JPEG image by camera’s default resolution. 

http://192.168.0.200/snap480p 

Return: Requested JPEG image 

 

 

<JPEG image data> 

\r\n 

 

Example: Request JPEG image by camera’s 720P resolution. 

http://192.168.0.200/snap720p 

Return: Requested JPEG image 

HTTP/1.0 200 OK\r\n 

Content-Type: image/jpeg\r\n 

[ Content-Length: <image size>\r\n ] 

\r\n 

Note: This 192.168.0.200/snap CGI is across all LILIN IP camera platforms. 
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Syntax: 

http://<serverIP>/snap?credentail=<base64> 

 

 Example: 

 http://192.168.0.200/snap?credentail=YWRtaW46cGFzcw== 

 Parameters: 

Parameter Values Description 

Base64=<string> <admin>:<pass> Base64 encoded string for admin:pass 

<admin> String User name 

<pass> String Password 

  

 Note: LILIN default username and password is admin and pass.  Base64 streaming is 

 YWRtaW46cGFzcw== for admin:pass.   

D:\Documents\SDK\IPCamSDK D:\Documents\SDK\IPCamSDK 

 

Chapter 3.1.2.  MJPEG video (server-push) 

When an MJPG video is requested, the server either returns continuous flow of jpeg images or an 

image with an error image (No Video | Not Permission | Not available) returned. The content type is 

“multipart/x-mixed-replace” and each image ends with a boundary string <boundary>. The returned 

image and HTTP data are equal to the request for a single JPEG image. 

Syntax: 

http://<serverIP>/getimage 

 

Example: Request JPEG image stream from the camera, by default D1 resolution. 

http://192.168.0.200/getimage 

Example: Request JPEG image stream from the camera for 1080P JPEG. 

http://192.168.0.200/getimage/getimage?fmt=1080p 

Example: Request JPEG image stream from the camera for 720P JPEG. 

http://192.168.0.200/getimage/getimage?fmt=720p 

Example: Request JPEG image stream from the camera for CIF JPEG. 

http://192.168.0.200/getimage/getimage?fmt=sif 

 

HTTP/1.0 200 OK\r\n 

Content-Type: multipart/x-mixed-replace;boundary=--<boundary>\r\n 

\r\n 

--<boundary>\n 

<image> 

--<boundary>\n 

<image> 

… 

where the <boundary> field in Merit LILIN digital device is  

<myboundary>\n 

and the returned <image> field is 

 

Content-Type: image/jpeg\n 

http://192.168.0.200/getimage?camera=0&fmt=sif
http://192.168.0.200/getimage?camera=0&fmt=sif
http://192.168.0.200/getimage?camera=0&fmt=sif
http://192.168.0.200/getimage?camera=0&fmt=sif
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Content-Length: <jpeg image size> Stamp:<YYYYMMDD 00HHmmss TK SSSSSSSS>\n\n 

<jpeg image data> 

 

where  

 

Stamp: Time stamp, of which format is with “Date”, “Time”, “Tick”, and “Sequence-number” 

 

 Field Bits Example 

Date: Year, A.D. 31-16 07d2=2002 AD 

 Month (1~12) 15-8  04=Apr 

 Day (1~31) 7-0 01=First 

Time: Hour (0~23) 31-16 0011=17 hr 

 Minute (0~59) 15-8  36=54 min 

 Second (0~59) 7-0 0e=14 sec 

Tick: Ticks(0~99) 7-0 09=90 ms from last sec. 

Seq: Seq (0~2
32

-1) 31-0 84b=2123 images since server start  

Syntax: 

http://<serverIP>/getimage?fmt=<res>&credentail=<base64> 

 

 Example: 

 http://192.168.0.200/getimage?fmt=480p&credentail=YWRtaW46cGFzcw== 

 http://192.168.0.200/getimage?credentail=YWRtaW46cGFzcw== 

 Parameters: 

Parameter Values Description 

Base64=<string> <admin>:<pass> Base64 encoded string for admin:pass 

<admin> String User name 

<pass> String Password 

  

 Note: LILIN default username and password is admin and pass.  Base64 streaming is 

 YWRtaW46cGFzcw== for admin:pass.   

 

Chapter 3.1.3. H.264 streaming  

See chapter 4 for detail. 

 

Chapter 3.1.3.1.  Streaming setting 

Get or set H.264 AVC video streaming setting. 

Syntax: 

 Parameters: 

Parameter Values Description 

cmd=<string> get,set It is necessary to choose what kind of command. 

‘get’=request the motion detection settings. 

‘set’=set the motion detection settings. 

vbrcbr=<int> 0,1 0=VBR, 1=CBR. 

biterate=<int> 56~3072 Biterate setting 

gop=<int> 0~2  
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outrate=<int> 0~30 Output frame rate 

entropy=<int> 0~1 CABLC/CABAC 

deinterlace=<int> 0~7 VLC de-interlace setting 

 

Chapter 3.1.4.  Audio configuration request 

Request audio configuration. 

Syntax: 

http://<serverIP>/getaudio 

 

Example #1: Request the audio configuration 

http://192.168.0.200/getaudio 

Return 1: Requested audio configurations 

 

  audio_enable=1  

  audio_sample_rate=8  

  audio_input_volume=50  

  audio_input_mode=1  

  audio_input_gain=0    

  audio_input_filter=1  

  audio_output_volume=50 

 

Chapter 3.1.4.1.  Audio setting 

Set H.264 AVC audio setting. 

Syntax: 

http://<serverIP>/setaudio[?<parameter>=<value>[&<parameter>=<value>…]] 

 

Parameters: 

Parameter Values Description 

audio_enable=<int> 0,1 0=Off, 1=On 

audio_sample_rate =<int> 0,1 0=8000Hz, 1=44.1KHz 

audio_input_volume =<int> 1~100 Audio volume 

audio_input_gain =<int> 0~3 0: 0dB, 1: +20dB 2: +26dB 3: +32dB 

audio_input_filter 0~3 0, 1, 2, 3 

audio_output_volume 1~100 Output volume 

 

Chapter 3.1.4.2  Audio streaming 

See chapter 4 for detail. 

 

Chapter 3.2.  Clock adjustment 

Adjust or read the server clock. 
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Chapter 3.2.1.  Clock time request 

This function requests time from Merit LILIN IP cameras, video servers, or IP PTZ cameras 

Syntax: 

http://<serverIP>/getclock 

 

Return: requested time 

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: <content_length>\r\n 

\r\n 

hr=<hour>\n 

min=<minute>\n 

sec=<second>\n 

mn=<month>\n 

date=<date>\n 

year=<year>\n 

 

Example: Request time from the server 

http://192.168.0.200/getclock 

Return: Requested time from the server 

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 42\r\n 

\r\n 

hr=1\n 

min=20\n 

sec=38\n 

mn=1\n 

date=26\n 

year=2000\n 

You can try the CGI function with the browser. 
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The source of the HTML page is on the notepad. It’s the returned values that you request via the CGI 

command. 

  

Chapter 3.2.2.  Clock time adjust 

Syntax: 

http://<serverIP> /setclock?Time=<hour>:<minute>:<second>&Date=<year>/<month>/<date> 

 

Parameter Values Description 

<hour> 1~ 23 Hour 

<min> 1~59 Minute 

<sec> 1~59 Second 

<month> 1~12 Month 

<date> 1~30 Date 

<year> 0000~9999 Year 

 

Example: Request time from the server 

http://192.168.0.200/setclock?Time=21:23:22&Date=2012/02/28 

Chapter 3.2.3.  NTP time adjust 

Syntax: 

http://<serverIP>/apply.cgi?action=datetime_apply&ntpc_interval=<Interval> 

 

Parameter Values Description 

<interval> 0~ 3600 0: close NTP, 3600: Update every 3600 

seconds. 
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Chapter 3.3.  Server Device Configuration 

Chapter 3.3.1.  Server configuration request 

Request server’s configuration. 

Syntax: 

http://<serverIP>/server 

 

Example #1: Request the server configuration 

http://192.168.0.200/server 

Return: Requested server configurations 

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 244\r\n 

\r\n 

device name=webcam1\n 

MAC address=00-04-29-00-81-e0\n 

logoEnable=1\n 

Software Version=1.15\n 

Model=0\n 

TVSYSTEM=1\n 

Language=0\n 

DhcpEnable=0\n 

SysFeature=348992\n 

MaxUser=3/7 

 

 

  

 

 

 

 

 SysFeature is the decimal value (four bytes) representing features for a camera.  The features are 

 described as below: 

 

Constant Hex value Function Note  

SYS_ALARM_IN  0x01  Alarm in  

SYS_ALARM_OUT  0x02   Alarm out  

SYS_IR_REV 0x04  IR Cut feature  

SYS_IR_REV_EXT 0x08  IR Cut external input  

SYS_TV_OUT 0x10  analogue output  

SYS_EXT_PTZ 0x20 IP PTZ, Type = 1 Optical PTZ 

SYS_SD_CARD 0x40 SD card  

SYS_AUTO_FOCUS 0x80  Auto focus camera  

SYS_AUD_IN  0x100 Audio in model  

SYS_AUD_MIC_IN 0x200 MIC input  

Parameter Values Description 

MaxUser <IntCurrent/IntMax> IntCurrent= Current user count 

IntMax=Maximum user allowed  
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SYS_AUD_LINE_IN 0x400 Line in   

SYS_AUD_OUT 0x800 Line out/speaker out  

SYS_ALARM_MOTION 0x1000 Motion detection  

SYS_ALARM_FACE 0x2000  Face detection  

SYS_ALARM_AUDIO  0x4000 Audio detection  

SYS_ALARM_TAMPER 0x8000 Tampering detection  

SYS_ALARM_NET 0x10000 Network lose detection  

SYS_ROI_RPTZ 0x20000 ROI, ePTZ, Type = 2  

SYS_PRI_MASK  0x40000 //Mask feature  

SYS_SENSOR_2710 0x80000 Reserve  

SYS_VARIFOCAL 0x100000 Varifocal camera  

SYS_FISHEYE  0x200000  // Fisheye, Type = 3  

SYS_IRLED 0x400000 //Reserve  

SYS_ALARM_WIRE 0x800000 Cross wire detection Tentative 

SYS_COLOR_LINE 0x1000000 Color and wire detection Tentative 

SYS_PEOPLECOUNT 0x2000000 People counting Tentative 

SYS_TRACKING 0x4000000 Tracking speed dome Tentative 

 

 Example: 

  SysFeature=348992=0x55340, please use 0x55340 AND above constants to get supported 

  feature.  

 

Chapter 3.4.  Network configuration 

Chapter 3.4.1.  Network configuration setting 

Syntax: 

http://<serverIP>/setnetwork[?<parameter>=<value>[&<parameter>=<value>…]] 

 

Parameters: 

 

Parameter Values Description 

save=<int> 0,1 Save the configurations to EEPROM. 

0=no, 1=yes. 

IP address=<string> <characters> IP address of the server. 

subnet mask=<string> <characters> Subnet mask for the server domain. 

web server IP=<string> <characters> Deprecated. 

web server name=<string> <characters> Deprecated. 

dns1=<string> <characters> The 1st DNS server. 

dns2=<string> <characters> The 2nd DNS server 

dns3=<string> <characters> The 3rd DNS server 

gateway=<string> <characters> The gateway of the domain. 

http_port=<int> 1~65535 The Http connection port number. 

 

Example: Set the server IP address to 192.168.0.129, subnet mask to 255.255.255.0, the 1st DNS 

server to 192.168.0.1, 2nd DNS server to 0.0.0.0, 3rd DNS server to 0.0.0.0, gateway to 

192.168.0.254, and the Http connection port to 3080. 

http://192.168.0.200/setnetwork?save=1&IP address=192.168.0.200&subnet 
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mask=255.255.255.0&dns1=192.168.0.1&dns2=0.0.0.0&dns3=0.0.0.0&gateway=192.168.0.254&

http_port=3080 

Chapter 3.4.2.  Network configuration request 

Syntax:  

http://<serverIP>/network 

 

Example: request the network configuration 

http://192.168.0.200/network 

Return: Requested network configurations 

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 124\r\n 

\r\n 

IP address=192.168.0.200\n 

subnet mask=255.255.255.0\n 

gateway= 192.168.0.1 

dns1=192.168.0.1\n 

dns2=0.0.0.0\n 

dns3=0.0.0.0\n 

gateway=192.168.0.254\n 

http_port=3080\n 

 

Chapter 3.5.  User configuration 

Chapter 3.5.1.  User configuration setting 

Syntax: 

http://<serverIP>/setusers[?<parameter>=<value>[&<parameter>=<value>…]] 

 

Parameters: 

Parameter Values Description 

tag=<int> 1,2,3,4 Command type:  

1=add, 2=modify, 3=delete, 4=who am I. 

name=<string> <characters> User name 

password=<string> <characters> Password 

priority=<int> 0,..,100 Deprecated 

admin checked=<int> <characters> Administration permission 

0=disable, 1=enable 

see image=<int> 0,1 Deprecated 

see video=<int> 0,1 Deprecated 

change param=<int> 0,1 Permission to change the Image type (Full, SIF, or 
QSIF) 
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0=disable, 1=enable 

see source1=<int> 0,1 Permission to see video source 1  
0=disable, 1=enable 

see source2=<int> 0,1 Permission to see Video source 2 

0=disable, 1=enable 

see source3=<int> 0,1 Permission to see Video source 3 

0=disable, 1=enable 

see source4=<int> 0,1 Permission to see Video source 4 

0=disable, 1=enable 

see source_all=<int> 0,1 Permission to see the 4-split Video 

0=disable, 1=enable 

 

Example: Add a user with name=admin and password=admin. Set this user with administration 

permission, change image type permission, see video 1 to 4, and see 4-split video permission. 

http://192.168.0.200/setusers?tag=1&name=admin&password=admin&admin 

checked=1&change param=1&see source1=1&see source2=1&see source3=1&see 

source4=1&see source_all=1 

Chapter 3.5.2.  User configuration request 

Syntax: 

http://<serverIP>/users 

 

Example: Request the user configuration  

http://192.168.0.200/users 

Return: Requested user configurations 

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 326\r\n 

\r\n 

amount=2\n 

name=admin\n 

password=admin\n 

priority=0\n 

admin checked=1\n 

see image=0\n 

see video=0\n 

change param=1\n 

see source1=1\n 

see source2=1\n 

see source3=1\n 

see source4=1\n 
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see source_all=1\n 

name=guest\n 

password=guest\n 

priority=0\n 

admin checked=0\n 

see image=0\n 

see video=0\n 

change param=1\n 

see source1=1\n 

see source2=1\n 

see source3=1\n 

see source4=1\n 

see source_all=1\n 

 

Chapter 3.6.  Video configuration 

Chapter 3.6.1.  Change video profile  

Change video profile. 

Syntax:  

http://<serverIP>/setstreaming?changeprofile=<value> 

 

Where: <value> = 1~4 

 

Example: Change profile to #2 streaming profile. 

  

http://192.168.0.200/setstreaming?changeprofile=2 

 

Return: Requested countdown script. 

 

<html> 

<head> 

<link href="template.css" rel="stylesheet" type="text/css"></head><body onload="clock(); return 

true;" class=body> 

<script language=javascript>.var i = 90; 

function clock() 

{ 

   i=i-1; document.formnow.dd.value = i; 

if(i>0) setTimeout("clock();",1000);  

else window.location.replace("/"); 

}</script><center> 

<br><br> 

<form name=formnow> 

<font color=#000000> 

Update OK Waiting For System Reboot  

&nbsp;<input type=text name=dd size=2> sec 

</form> 

</body> 

</html> 

 

 
Note: Change profile needs 90 seconds reboot time.  Change frame rate and bitrate that do not 

need reboot. 
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Chapter 3.6.2.  Change video profile for 120FPS camera 

Example: Change output frame rate 

  

  http://192.168.0.200/setstreaming?profilename=H2641080P&outrate=120 

 

Parameters: 

Parameter Values Description 

outrate=<int> 1~120 Output frame rate 

 

Chapter 3.7.  Get and set video configuration 

Chapter 3.7.1.  Get video configuration 

Get H.264 AVC video compression configuration. 

Syntax:  

http://<serverIP>/getstreaming 

Example: Request H.264 AVC video compression configuration 

http://192.168.0.200/getstreaming 

Return: Requested video configurations 

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 308\r\n 

\r\n 

outrate=30 profilename=H2641080P profile_00_quality=20  

outrate=5 profilename=JPEG480P profile_01_quality=60  

outrate=15 profilename=H264480P profile_02_quality=20  

outrate=5 profilename=JPEGCIF profile_03_quality=70 

\r\n 

 

Chapter 3.7.2.  Set video configuration 

Set H.264 AVC video configuration. 

Syntax: 

http://<serverIP>/setstreaming[?<parameter>=<value>[&<parameter>=<value>…]] 

Parameters: 

 

Parameter Values Description 

profilename=<string> <characters> Streaming profile  
(H.264 HD IP camera) 
(H.264 2,3MP IP camera) 

vbrcbr =<int> 0/1 0:CBR,1:VBR 

bitrate =<int> 128~5120 Kbps Bit rate of connection (H.264 2,3MP IP camera) 

iframeperiod=<int> 1~30 I frame period (H.264 2,3MP IP camera) 

http://192.168.0.200/setstreaming?profilename=H2641080P&outrate=120
http://192.168.0.200/getstreaming
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outrate =<int> 1~30 Parameter of frame rate.  

 (H.264 2,3MP IP camera) 

quality=<int> 20~80 20:Low~80:High (H.264 2,3MP IP camera) 

 

Example: Set profile H2641080P for CBR at 2MBps bitrate and 20 FPS. 

 

http://192.168.0.200/setstreaming?profilename=H2641080P&vbrcbr=1&bitrate=2048&outrate=20 

http://192.168.0.200/setstreaming?profilename=JPEGCIF&vbrcbr=0&outrate=6&bitrate=3072&qu

ality=30 

 

http://192.168.0.200/setstreaming?profilename=H264480P&vbrcbr=0&bitrate=512&iframeperiod=

30&outrate=30 

 

 

 

 

Chapter 3.7.3.  Get video streaming limitation 

 Get available streaming profiles, video streaming settings, and streaming limitations. 

Syntax: 

 

http://<serverIP>/getprofile 

 

Example: Get current available streaming profiles’ limitations 

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 308\r\n 

\r\n 

 
profileno=0 profileno_range=0,1,2,3 

profile_00_name=H2641080P profile_00_type=0 profile_00_mode=0 profile_00_gop=30 

profile_00_bps=3072 profile_00_res=1920x1080 profile_00_fps=30 profile_00_mode_range=0~1 

profile_00_gop_range=1~30 profile_00_fps_range=1~30 

profile_00_bps_range=1024,2048,3072,4096,5120,6144,7168,8192,9216,10240 

  

profile_01_name=JPEG480P  profile_01_type=1 profile_01_quality=60 profile_01_res=720x480 

profile_01_fps=5 profile_01_fps_range=1~30 profile_01_quality_range=20,30,40,50,60,70,80 

 

profile_02_name=H264480P  profile_02_type=0 profile_02_mode=0 profile_02_gop=15 

profile_02_bps=1024 profile_02_res=720x480 profile_02_fps=15 profile_02_mode_range=0~1 

profile_02_fps_range=1~30 profile_02_gop_range=1~30 

profile_02_bps_range=128,256,512,1024,2048,3072  

 

profile_03_name=JPEGCIF   profile_03_type=1 profile_03_quality=70 profile_03_res=352x240 

profile_03_fps=5 profile_03_fps_range=1~30 profile_03_quality_range=20,30,40,50,60,70,80 

\r\n 

 

Note: For HD IP camera, reboot is required for changing frame rate, bitrate, and resolution of H.264 

streaming,  Reboot is required for changing quality and frame rate of JPEG streaming., 

http://192.168.0.200/setstreaming?profilename=H2641080P&vbrcbr=1&bitrate=2048&outrate=20
http://192.168.0.200/setstreaming?profilename=JPEGCIF&vbrcbr=0&outrate=6&bitrate=3072&quality=30
http://192.168.0.200/setstreaming?profilename=JPEGCIF&vbrcbr=0&outrate=6&bitrate=3072&quality=30
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Parameters: 

 

Where: 

<num> is 0~3 for streaming ID. 

 

Parameter Values Description 

profileno 0~4 The current profile ID 

profileno_range  Profiles available 

profile_<num>_name String The name of the profile 

profile_<num>_type 0~1 0: H.264, 1: JPEG 

profile_<num>_mode  0: CBR, 1: VBR 

profile_<num>_gop  Current GOP setting 

profile_<num>_bps See mode range. Current bitrate setting 

profile_<num>_res  Current resolution setting 

profile_<num>_fps  Current FPS setting 

profile_<num>_mode_range 0~1 The range of 0: CBR, 1: VBR 

profile_<num>_gop_range  The range of GOP 

profile_<num>_fps_range  The range of FPS 

profile_<num>_bps_range  The range of bitrate 

profile_<num>_quality  Current JPEG quality setting (JPEG stream only) 

profile_<num>_quality_rang  JPEG quality range (JPEG stream only) 

 

Chapter 3.7.4.  Get URL 

Get available RTSP uniform resource identifiers (URLs) information for a streaming profile. 

Syntax: 

 

http://<serverIP>/geturl 

 

Return: Available RTSP string  

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 244\r\n 

\r\n 

 rtsp://192.168.0.200/rtsph2641080p 

 rtsp://192.168.0.200/rtsph264480p 

 rtsp://192.168.0.200/rtspjpeg480p 

 rtsp://192.168.0.200/rtspjpegcif 

 

Chapter 3.7.5.  Set video Flip 

Set video Filp. 

Syntax: 

 

http://<serverIP>/flip 

 

Chapter 3.7.6.  Set video Mirror 

Set video Mirror. 

 

Syntax: 
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http://<serverIP>/mirror 

 

Chapter 3.7.7.  Set user OSD  

Set user defined OSD on video 

 

Syntax: 

 

http://<serverIP>/setosd?myosd=<userdefinedosd> 

 

Where: 

The length of OSD can not exceed 40 characters and only 1080P video has the user defined OSD. 

 

Syntax: 

 

http://<serverIP>/setosd?myosd=<userdefinedosd>&pos=<myPOS> 

Parameters: 

Parameter Values Description 

userdefinedosd String  

myPOS String topleft, topright, bottomleft, bottomright 

 

Chapter 3.7.8.  Set privacy mask  

Set user defined privacy mask 

Syntax: 

http://<serverIP>/privacymask[?<parameter>=<value>[&<parameter>=<value>…]] 

Parameters: 

Parameter Values Description 

cmd=<string> set ‘set’=set the privacy mask settings. 

pmID=<int> 1~4 Privacy mask ID, there are total four masks. 

privacy_enable =<int> 0,1 Privacy mask feature enable or disable 

0=disable, 1=enable. 

pmBlock=<int> 0v~239v Array of blocks for privacy mask 

 

Privacy mask array: 

0v 1v 2v 3v 4v 5v 6v 7v 8v 9v 10v 11v 12v 13v 14v 15v 16v 17v 18v 19v 

20v 21v 22v 23v 24v 25v 26v 27v 28v 29v 30v 31v 32v 33v 34v 35v 36v 37v 38v 39v 

40v 41v 42v 43v 44v 45v 46v 47v 48v 49v 50v 51v 52v 53v 54v 55v 56v 57v 58v 59v 

60v 61v 62v 63v 64v 65v 66v 67v 68v 69v 70v 71v 72v 73v 74v 75v 76v 77v 78v 79v 

80v 81v 82v 83v 84v 85v 86v 87v 88v 89v 90v 91v 92v 93v 94v 95v 96v 97v 98v 99v 

100v 101v 102v 103v 104v 105v 106v 107v 108v 109v 110v 111v 112v 113v 114v 115v 116v 117v 118v 119v 

120v 121v 122v 123v 124v 125v 126v 127v 128v 129v 130v 131v 132v 133v 134v 135v 136v 137v 138v 139v 

140v 141v 142v 143v 144v 145v 146v 147v 148v 149v 150v 151v 152v 153v 154v 155v 156v 157v 158v 159v 

160v 161v 162v 163v 164v 165v 166v 167v 168v 169v 170v 171v 172v 173v 174v 175v 176v 177v 178v 179v 

180v 181v 182v 183v 184v 185v 186v 187v 188v 189v 190v 191v 192v 193v 194v 195v 196v 197v 198v 199v 
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200v 201v 202v 203v 204v 205v 206v 207v 208v 209v 210v 211v 212v 213v 214v 215v 216v 217v 218v 219v 

220v 221v 222v 223v 224v 225v 226v 227v 228v 229v 230v 231v 232v 233v 234v 235v 236v 237v 238v 239v 

 

Example: Set the privacy mask block of ID1. 

 

http://192.168.0.200/privacymask?cmd=set&privacy_enable=1&pmID=1&pmBlock=0v1v20v21v 
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Chapter 3.7.9.  Clear privacy mask  

Clear privacy mask. 

 

Syntax: 

 

http://<serverIP>/privacymask?cmd=set&pmClear<PrivacyMask> 

 

Example: Clear all privacy masks. 

http://192.168.0.200/privacymask?cmd=set&pmClear=0 

 

Example: Clear privacy mask #2. 

http://192.168.0.200/privacymask?cmd=set&pmClear=2 

 

Chapter 3.8.  PTZ configuration 

Chapter 3.8.1.  PTZ commands 

Send the PTZ command. 

Syntax:  

http://<serverIP>/control[?<parameter>=<value>[&<parameter>=<value>…]] 

Parameters: 

Parameter Values Description 

camid=<int> 1~4 Camera channel for pan, tilt, or zoom 

panpos=<int> 0~19199 Parameter of pan control to a absolute position 
(IPS0/1) 

0~12799 Parameter of pan control to a absolute position 
(IPS4/5/6/7 Series) 

0~15999 Parameter of pan control to a absolute position 
(IPS2/3/8/9 Series) 

tiltpos=<int> 1120~6560 Parameter of tilt control to a absolute position 
(IPS0/1 series) 

467  
~2734 

Parameter of tilt control to a absolute position 
(IPS4/5/6/7 Series) 

0~3999 Parameter of tilt control to a absolute position 
(IPS2/3/8/9 Series) 

zoompos=<int> 25~1197 Parameter of zoom control to a absolute position 

64~2465 Parameter of zoom control to a absolute position 

(IPS025/125) 

64~2520 Parameter of zoom control to a absolute position 

(IPS030/130) 

64~2548 Parameter of zoom control to a absolute position 

(IPS035/135) 

0~782 Parameter of zoom control to a absolute position 

(IPS203/303) 

64~1334 Parameter of zoom control to a absolute position 

(IPS212/312) 

 0~19184 Parameter of zoom control to a absolute position 

(IPS836/936) 

 0~34320 Parameter of zoom control to a absolute position 
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(IPS826/926)) 

 0~2333~6029 Parameter of zoom control to a absolute position 

(IPS622/722) 

 0~16384~31424 Parameter of zoom control to a absolute position 

(IPS420/520) 

 0~10080 Parameter of zoom control to a absolute position 

(IPS418/518) 

rpan=<int> -7~7 Pan relatively (positive value means pan right) 

rtilt=<int> -7~7 Tilt relatively (positive value means tilt up) 

rzoom=<int> -7~7 Zoom relatively (positive value means zoom out) 

rotate=1 1 Rotate 180 

stop 1 Stop relative Pan 

panposdegree=<int> 0~359 Pan degree 

tiltposdegree=<int> -6~96 Tilt degree 

zoomposdegree=<int> 1~36 Zoom degree 

cmd=getpanpos  Get pan position 

cmd=gettiltpos  Get tilt position 

cmd=getzoompos  Get zoom position 

cmd=getallpos  Get all position 

cmd=getpanposdegree  Get pan degree 

cmd=gettiltposdegree  Get tilt degree 

cmd=getzoomposdegree  Get zoom degree 

cmd=getallposdegree  Get pan degree,tilt degree and zoom degree 

type 1~4 3: fish eye, 4: auto focus model 

 

Example: Set the camera 1 to pan right with speed 7 without stop. 

http://192.168.0.200/control?camid=1&rpan=7 

Example: Set the camera 1 to stop. 

http://192.168.0.200/control?stop=1 

Example: Set the camera 1 to pan right with speed 7 and stop. 

http://192.168.0.200/control?camid=1&rpan=7&stop=1 

Example: Set the camera 1 to pan to position 33. 

http://192.168.0.200/control?camid=1&panpos=1911 

Example: Set camera 1 to zoom out relatively.  

http://192.168.0.227/control?rzoom=-3 

Example: Set camera 1 to zoom out a bit and then stop zooming immediately.  

http://192.168.0.227/control?rzoom=3&stop=1 

Example: Set camera 1 to pan 180 degree, tilt 45 degree, zoom 10.  

http://192.168.0.227/control?panposdegree=180&tiltposdegree=45&zoomposdegree=10 

http://192.168.0.200/control?camid=1&rpan=7
http://192.168.0.200/control?camid=1&panpos=1911
http://192.168.0.227/control?rzoom=3&stop=1
http://192.168.0.227/control?panposdegree=180&tiltposdegree=45&zoomposdegree=10
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Example: Get camera 1 pan, tilt and zoom degree.  

http://192.168.0.227/control?cmd=getallposdegree 

Chapter 3.8.2.  PTZ preset setting 

Set the PTZ preset points command. 

Syntax: 

http://<serverIP>/ptzpreset[?<parameter>=<value>[&<parameter>=<value>…]] 

 

Parameters: 

 

Parameter Values Description 

camid=<int> 1~4 Camera number for preset settings 

goto_preset=<int> 0,..,19 Goto a preset position according to the preset 
number. 

set_preset=<int> 0,..,19 Assign a preset number to a preset position. 

autopan 0/1 0: stop auto pan/1: start auto pan 

 

Example: Set camera ID #1 to go to preset point #3. 

http://192.168.0.200/ptzpreset?camid=1&goto_preset=3 

Example: Set the camera ID #1 to remember the PTZ position to preset point #11. 

http://192.168.0.200/ptzpreset?camid=1&set_preset=11 

Example: Remove a preset name according the preset point 5. 

http://192.168.0.200/ptzpreset?camid=1&rem_preset=5 

 

Chapter 3.8.3.  PTZ lens setting 

Send the PTZ iris/focus command. 

Syntax:  

http://<serverIP>/camera[?<parameter>=<value>[&<parameter>=<value>…]] 

Parameters: 

 

Parameter Values Description 

iris=<int> 1,-1 Iris relatively (positive value means Iris large) 

autoiris=<int> 1 Set auto iris. 

focus=<int> 1,-1 Focus relatively (positive value means Focus far) 

autofocus=<int> 1 Set auto focus. 

 

Note: IPS4, IPS5, IPS8, and IPS9 do support manual iris for iris+ and iris-. 

http://192.168.0.227/control?cmd=getallposdegree
http://192.168.0.200/ptzpreset?camid=1&rem_preset=5
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Example: Set camera 1 to iris large 

http://192.168.0.200/camera?iris=1 

http://192.168.0.200/control?stop=1 

Example: Set camera 1 to focus near. 

http://192.168.0.200/camera?focus=-1 

http://192.168.0.200/control?stop=1 

Example: Set camera 1 to auto iris. 

http://192.168.0.200/camera?autoiris=1 

Chapter 3.8.4. Auto focus adjustment 

For auto focus camera, please use the following CGI commands:  

Zoom in:   http://192.168.0.200/control?zoom=-1&type=4 

Zoom out:   http://192.168.0.200/control?zoom=1&type=4 

Auto focus:  http://192.168.0.200/camera?autofocus=1&type=4 

Focus near:  http://192.168.0.200/camera?focus=-1&type=4 

Focus far:   http://192.168.0.200/camera?focus=1&type=4 

 

Chapter 3.8.5. ROI adjustment 

 Set region of interest cropping window. Please make sure that the ROI feature is enabled. For ROI 

 mode, streaming #1 is used for main streaming. The rest of streaming 2, 3, and 4 can be cropped 

 based on streaming #1 

Syntax: 

http://<serverIP>/control[?<parameter>=<value>[&<parameter>=<value> 

 

http://192.168.0.200/control?zoom=-1&type=4
http://192.168.0.200/control?zoom=1&type=4
http://192.168.0.200/camera?autofocus=1&type=4
http://192.168.0.200/camera?focus=-1&type=4
http://192.168.0.200/camera?focus=1&type=4
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Parameters: Parameter  Values  Description  

streamno=<int>  2, 3, 4  Streaming #2, #3, and #4  

dptzdirect =<int>  1  Enable direct positioning digital PTZ based on X and Y 

coordinates.  

dptzx =<int>  0~319/0~719  Cropping start X position of the streaming resolution  

dptzy =<int>  0~239/0~479  Cropping start Y position of the streaming resolution  

Dptzw =<int>  0~319/0~719  Cropping width of the streaming resolution  

Dptzh = <int>  0~239/0~479  Cropping height of the streaming resolution  

 

 Example: Crop the video on streaming #2 at D1 (720 * 480) resolution starting at 6 pixel of the x 

 direction with width 703 pixel and starting at 4 pixel of the y direction with 467 height.  

 

  http://<serverIP>/control?streamno=2&dptzdirect=1&dptzx=6&dptzy=4&dptzw=703&dptzh=467 

 

 Example: Disable ROI feature on streaming #2 and return to home position.   

  http://<serverIP>/control?home=1&streamno=2 
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Chapter 3.9.  System Functions 

Chapter 3.9.1.  Reboot server 

Reboot the server. 

Syntax: 

http://<serverIP>/control?reboot=1 

 

Example: Request the server to reboot. 

http://192.168.0.200/reboot 

Chapter 3.9.2.  Get reboot time 

Get the time of last reboot. 

Syntax: 

http://<serverIP>/control?getreboot 

 

Example: Request the time of reboot. 

http://192.168.0.200/control?getreboot 

Return: 2014/01/02 20:21:32 

 

Chapter 3.9.3.  Factory default 

Restore configurations to factory default. 

Syntax: 

http://<serverIP>/factorydefault 

 

Example: Request the server to load factory default. 

http://192.168.0.200/factorydefault 

Chapter 3.10.  Video quality adjustment 

Syntax:   

http://<serverIP>/quality[?<parameter>=<value>[&<parameter>=<value>…]] 

Parameters: 

Parameter Values Description 

cmd=<string> set,get It is necessary to choose what kind of command: 

‘set’=set the video quality settings. 

‘get’=get the video quality settings. 

DayNight=<int> 0,1 

 
Set/get day quality is 0  

Set/get night quality is 1 

EV=<int> 1~16 Exposure Value 

WDR=<int> 0,1 0=Off, 1=On 

BLC=<int> 0,1 Back-light Compensation 0=off, 1=On 

http://192.168.0.200/reboot
http://192.168.0.200/control?getreboot
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ShutterLimitmin=<int> 30~8000 Shutter Limit(sec): Min 

30=1/30, 50=1/50, 60=1/60, 100=1/100, 120=1/120, 

160=1/160, 200=1/200, 240=1/240, 320=1/320, 

400=1/400, 480=1/480, 640=1/640, 800=1/800, 

1000=1/1000, 1600=1/1600, 2000=1/2000, 3000=1/3000, 

4000=1/4000, 6000=1/6000, 8000=1/8000 

ShutterLimitmax=<int> 30~8000 Shutter Limit(sec): Max 

30=1/30, 50=1/50, 60=1/60, 100=1/100, 120=1/120, 

160=1/160, 200=1/200, 240=1/240, 320=1/320, 

400=1/400, 480=1/480, 640=1/640, 800=1/800, 

1000=1/1000, 1600=1/1600, 2000=1/2000, 3000=1/3000, 

4000=1/4000, 6000=1/6000, 8000=1/8000 

AGC=<int> 1~6 Auto Gain Control 

1=2x(6dB), 2=4x(12dB), 3=8x(18dB), 4=16x(24dB), 

5=32x(30dB), 6=64x(36dB) 

NoiseReduction=<int> 0~32 3D Noise Reduction 

SenseUp=<int> 0~4 Sense Up 

0=Off, 1=1 frame, 2=2 frames, 3=3 frames,4=7 frames 

AWB=<int> 0~6 White Balance Control 

0=Auto, 1=Tungsten, 2=Fixed Indoor, 3=Fixed 

Fluorescents 1, 4=Fixed Fluorescents 2, 5=Fixed 

Outdoor1, 6=Fixed Outdoor2 

MIRROR=<int> 

 

0,1 Mirror 

0=Off, 1=On 

FLIP=<int> 0,1 Flip 

0=Off, 1=On 

 

Example: Set the video quality . 

http://192.168.0.200/quality?cmd=set&DayNight=0&EV=7&WDR=1&BLC=0&ShutterLimitmin=80

00&ShutterLimitmax=30&AGC=2&NoiseReduction=2&SenseUp=0&AWB=0&MIRROR=0&FLIP=

0 

Example: Request the video quality. 

http://192.168.0.200/quality?cmd=get&DayNight=0 

Return: Requested video quality settings 

HTTP/1.0 200 OKDate: Wed, 08 Feb 2012 06:43:22 GMTConnection: closeContent-Type: 

text/htmlContent-Length: 112 

EV=7 

WDR=1 

BLC=0 

ShutterLimitmin=8000 

ShutterLimitmax=30 

AGC=2 

NoiseReduction=2 

SenseUp=0 

AWB=0 

MIRROR=0 

FLIP=0 

 

Chapter 3.10.1. Video quality adjustment 

Syntax:   



MERIT LILIN CO., 

LTD 

29 MERIT LILIN CO., 

LTD 

29 

 

 

http://<serverIP>/camctrl[?<parameter>=<value>[&<parameter>=<value>…]] 

Parameters: 

Parameter Values Description 

cmd=<string> set,get It is necessary to choose what kind of command: 

‘set’=set the video quality settings. 

‘get’=get the video quality settings. 

‘camstat’=return the format of the connected video. (0=No 

Video, 1=NTSC, 2=SECAM, 3=PAL) 

contrast=<int> -50~50 Contrast level adjustment 

bright=<int> -50~50 Brightness level adjustment 

hue=<int> -50~50 Hue level adjustment 

Saturation=<int> -50~50 Saturation level adjustment 

Sharpness=<int> 0~31 Sharpness level adjustment 

camstat=<int> 1,3 TV Out(1=NTSC, 3=PAL) 

 

Example: Set the video quality of video. 

http://192.168.0.200/camctrl?cmd=set&contrast=0&bright=0&hue=0&Saturation=0&Sharpness=0

&camstat=3 

Example: Get the video quality of video. 

http://192.168.0.200/camctrl?cmd=get 

Return: Requested video quality settings 

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 114\r\n 

\r\n 

bright=0\n 

contrast=0\n 

hue=0\n 

Saturation=0\n 

Sharpness=0\n 

camstat=3\n 

 

Chapter 3.11.  Motion detection configuration 

Syntax:  

http://<serverIP>/motion[?<parameter>=<value>[&<parameter>=<value>…]] 

 

http://192.168.0.200/camctrl?cmd=set&contrast=0&bright=0&hue=0&Saturation=0&Sharpness=0
http://192.168.0.200/camctrl?cmd=set&contrast=0&bright=0&hue=0&Saturation=0&Sharpness=0
http://192.168.0.200/camctrl?cmd=get
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Parameters: 

 

 

 

 

 

 

 

 

 

 

 

Parameter Values Description 

cmd=<string> get,set It is necessary to choose what kind of command. 

‘get’=request the motion detection settings. 

‘set’=set the motion detection settings. 

mdEv=<int> 0,1 Motion detection feature enable or disable 

0=disable, 1=enable. 

mdSen=<int> 1~30 Motion detection sensitivity, larger value means less 
sensitive. Default value is 5. 

mdFreq=<int> 1~100 Polling Frequency in 1/10 second. Default value is 5. 

mdX0=<int> 0~10 Left most coordinates of grid number 

mdX1=<int> 0~10 Right most coordinates of grid number 

mdY0=<int> 0~6 Top coordinates of grid Number 

mdY1=<int> 0~6 Bottom coordinates of grid number 

MdBlock=<int>[,<int>,..] 0,..,76 Series of blocks for detect motion if using GRID method. 
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Example: Request the motion detection configuration. 

http://192.168.0.200/motion?cmd=get&camid=1 

Return: Requested motion detection configuration 

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 

30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 

45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 

60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 

75 76 77 78 79 80 81 82 83 84 85 86 87 88 89 

90 91 92 93 94 95 96 97 98 99 100 101 102 103 104 

105 106 107 108 109 110 111 112 113 114 115 116 117 118 119 

120 121 122 123 124 125 126 127 128 129 130 131 132 133 134 

135 136 137 138 139 140 141 142 143 144 145 146 147 148 149 

Parameter Values Description 

cmd=<string> get,set It is necessary to choose what kind of command. 

‘get’=request the motion detection settings. 

‘set’=set the motion detection settings. 

mdEv=<int> 0,1 Motion detection feature enable or disable 

0=disable, 1=enable. 

mdSen=<int> 1~99 Motion detection sensitivity, larger value means less 
sensitive. Default value is 30. 

mdX0=<int> 0~14 
0~19 

Left most coordinates of grid number 
(H.264 D1 IP camera) 
Left most coordinates of grid number 
(H.264 HD IP camera) 

mdX1=<int> 0~14 
 
0~19 

Right most coordinates of grid number 
(H.264 D1 IP camera) 
Right most coordinates of grid number 
(H.264 HD IP camera) 

mdY0=<int> 0~9 
 
0~11 

Top coordinates of grid Number 
(H.264 D1 IP camera) 
Top coordinates of grid Number 
(H.264 HD IP camera) 

mdY1=<int> 0~9 
 
0~11 

Bottom coordinates of grid number 
(H.264 D1 IP camera) 
Bottom coordinates of grid number 
(H.264 HD IP camera) 

MdBlock=<int>[,<int>,..] 0v,…149v 
 
0v,…239v 

Series of blocks for detect motion if using GRID 

method. (H.264 D1 IP camera) 
Series of blocks for detect motion if using GRID 
method. (H.264 HD IP camera) 



MERIT LILIN CO., 

LTD 

32 MERIT LILIN CO., 

LTD 

32 

 

 

 

HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 48\r\n 

\r\n 

mdEv=1\n 

mdSen=5\n 

mdFreq=5\n 

mdBlock=1:12:13\n 

 

Chapter 3.12.  GPIO functions 

Chapter 3.12.1.  Set relay output. 

Enable the relay output of the IP camera. 

Syntax: 

http://<serverIP>/setio[?<parameter>=<value>[&<parameter>=<value>…]] 

Parameters: 

 

Parameter Values Description 

relay1=<int> 0/1 0=low, 1=high 

Input=<int> 0/1 0=normal close, 1=normal open 

 

Example: Set GPIO relay configuration. 

 http://192.168.0.200/setio?relay1=1 

Chapter 3.13.  Alarm or motion notification via email or FTP 

Chapter 3.13.1.  Email notification 

 Get email notification configuration. 

Syntax: 

 

http://<serverIP>/setnotification[?<parameter>=<value>[&<parameter>=<value>…]] 

  

Example 

http://192.168.0.200/setnotification?rcvaddress=receiver@mail.com&sndaddress=sender@mail.c

om&smtpserver=mail.com 

Parameters: 

 SMTP setting version #1 

Parameter Values Description 

rcvaddress=<string> characters Email recipient 

http://192.168.0.200/setio?relay1=1
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sndaddress=<string> characters Sender email address 

smtpserver=<string> characters SMTP server 

Authentication=<int> 0/1 0: disable 1: enable 

authaccount=<string> characters SMTP server’s account name 

authpassword=<string> characters SMTP server’s password 

 

 SMTP setting version #2 

 

 Chapter 3.13.2.  FTP notification 

 Get or set FTP notification configuration. 

 

http://<serverIP>/setnotification[?<parameter>=<value>[&<parameter>=<value>…]] 

 

Example 

http://192.168.0.200/getnoification 

Parameters: 

 

Parameter Values Description 

FTP get,set Get/set 

Parameter Values Description 

rcvaddress=<string> characters Email recipient 

mail_auto_en=<int> 0/1 0: disable 1: enable auto e-mail sent 

email_timer=<int> 60~3600 Auto e-mail sent dwell time(sec.) 

am_email_flag=<int> 0/1 0: disable 1: enable event detection e-mail sent 

mail_alarmin_en=<int> 0/1 0: disable 1: enable alarm input detection sent mail 

mail_motion_en=<int> 0/1 0: disable 1: enable motion detection sent mail 

mail_face_en=<int> 0/1 0: disable 1: enable face detection sent mail 

mail_audio_en=<int> 0/1 0: disable 1: enable audio detection sent mail 

mail_tamper_en=<int> 0/1 0: disable 1: enable tamper detection sent mail 

am_email_sec=<int> 5~300 Event detection e-mail sent dwell time(sec.) 

sndaddress=<string> characters Sender email address 

smtpserver=<string> characters SMTP server 

smtp_auth_mode=<int> 0/1 0: Auth Login 1: Auth SSL 

smtp_email_port=<int> 25~65535 SMTP server port 

Authentication=<int> 0/1 0: disable 1: enable Athentication 

authaccount=<string> characters SMTP server’s account name 

authpassword=<string> characters SMTP server’s password 
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ftpaddress string FTP address 

ftpaccount string FTP account 

ftppass string FTP password 

ftppath string FTP path 

 

Chapter 3.13.3.  Alarm and motion status 

    Get alarm and motion status 

 

http://<serverIP>/getalarmmotion 

 

 Example: 

 

  http://192.168.0.200/getalarmmotion 

 

 Return: alarm and motion detect status 

 

   --myboundary\r\n 

Content-Type: text/plain\r\n 

CamTime:2011-07-28 11:11:01\r\n 

MotionDetect=0\r\n 

AlarmInputDetect=0\r\n 

AudioDetect=0\r\n 

TemperDetect=0 

FaceDetectNumber=0\r\n 

--myboundary\r\n 

 

Content-Type: text/plain\r\n 

CamTime:2011-07-28 11:11:02\r\n 

MotionDetect=0\r\n 

AlarmInputDetect=0\r\n 

AudioDetect=0\r\n 

TemperDetect=0\r\n 

FaceDetectNumber=0\r\n 

--myboundary\r\n 

 

   Chapter 3.13.4.  Post alarm and motion status 

 LILIN IP can send HTTP Post protocol to a VMS server or a controller for alarm notification.   

 

Syntax: 

 

http://<serverIP>/sethttppost[?<parameter>=<value>[&<parameter>=<value>…]] 

  

  Example: 

 

http://192.168.0.200/sethttppost?destip=192.168.1.212&destport=23352&url=%2Falarmnotificatio

n?&SysFeature=0x2000000&httppost_en=1&httppostjpeg_en=1&alarm_en=1&motion_en=1&fac

e_en=1&audio_en=1&tamper_en=1&account=admin&password=pass&dwell=5 

http://192.168.0.200/getalarmmotion
http://192.168.0.200/sethttppost?destip=192.168.1.212&destport=23352&url=%2Falarmnotification?&SysFeature=0x2000000&httppost_en=1&httppostjpeg_en=1&alarm_en=1&motion_en=1&face_en=1&audio_en=1&tamper_en=1&account=admin&password=pass&dwell=5
http://192.168.0.200/sethttppost?destip=192.168.1.212&destport=23352&url=%2Falarmnotification?&SysFeature=0x2000000&httppost_en=1&httppostjpeg_en=1&alarm_en=1&motion_en=1&face_en=1&audio_en=1&tamper_en=1&account=admin&password=pass&dwell=5
http://192.168.0.200/sethttppost?destip=192.168.1.212&destport=23352&url=%2Falarmnotification?&SysFeature=0x2000000&httppost_en=1&httppostjpeg_en=1&alarm_en=1&motion_en=1&face_en=1&audio_en=1&tamper_en=1&account=admin&password=pass&dwell=5
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Parameters: 

 

Parameter Values Description 

destip IP address string Destination’s IP address of the receiver 

destport Port number string Destination’s port number of the receiver 

url String The event URL for the receiver 

%2F is the “/” or slash in the URL. 

SysFeature String See Chapter 3.3.1. Server configuration request 

Only the following SysFeature is supported. 

SYS_ALARM_IN=0x01 

SYS_ALARM_TAMPER=0x8000 

SYS_ALARM_AUDIO=0x4000 

SYS_ALARM_FACE=0x2000 

SYS_ALARM_MOTION=0x1000 

SYS_ALARM_WIRE=0x800000 

SYS_COLOR_LINE=0x1000000 

SYS_PEOPLECOUNT=0x2000000 
httppost_en 0/1 0:disable,1:enable http post 

httppostjpeg_en 0/1 0:disable,1:enable http post jpeg attachment 

alarm_en 0/1 0:disable,1:enable http post alarm in detection 

motion_en 0/1 0:disable,1:enable http post motion detection 

face_en 0/1 0:disable,1:enable http post face detection 

audio_en 0/1 0:disable,1:enable http post audio detection 

tamper_en 0/1 0:disable,1:enable http post tamper detection 

account String Destination’s account of the receiver 

password String Destination’s password of the receiver 

dwell 1~5 http post dwell time (sec.) 

 

   Chapter 3.13.5.  Trigger email and FTP notification with snapshot 

To trigger a snapshot via email and FTP, you can  

Syntax: 

http://<serverIP>/trigger [?<parameter>=<value>[&<parameter>=<value>…]] 

 

Example: Trigger snapshot via FTP and email. 

 

  http://192.168.0.200/trigger?sendftp=1  

 

  http://192.168.0.200/trigger?sendmail=1 
 

  http://192.168.0.200/trigger?subject=user define subject 

 

 http://192.168.0.200/trigger?content=user define message 

http://192.168.0.200/trigger?sendftp=1
http://192.168.0.200/trigger?sendmail=1%20
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Parameters: 

 

Parameter Values Description 

sendftp 1 Send ftp snapshot via predefined FTP server. 

sendmail 1 Send email snapshot via predefined email server. 

User define subject Text  

User define message Test  

 

   Chapter 3.13.6.  Check Digital Input Status 

Example: 

  http://192.168.0.200/io?input=check 

 
Parameters: 

 

Parameter Values Description 

Input1 1 0 = N/O 

1= N/C 

 

   Chapter 3.13.7.  Check Relay Output Status 

Example: 

  http://192.168.0.200/io?relay=check 

Parameters: 

 

Parameter Values Description 

Relay  0 = No output 

1= Enable output 

 

   Chapter 3.14.  DDNS CGI 

 When Merit LILIN digital device enables the DDNS service, it “registers” to Merit LILIN DDNS server 

 with its information, such as server name to access, router virtual port number, and updated frequency, 

 etc.  Merit LILIN digital device automatically “updates” to DDNS server by a fix frequency, so even IP 

 of the digital device is changed by ISP, the DDNS server could still get and update internal database. 

 

Chapter 3.14.1.  Get DDNS configurations 

Get DDNS configuration from digital device. 

Syntax: 

http://<serverIP>/ddns?cmd=get 

 

Example #1: Query DDNS configurations. 

 

http://192.168.0.200/ddns?cmd=get 

 

http://192.168.0.200/io?input=check
http://192.168.0.200/io?relay=check
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HTTP/1.0 200 OK\r\n 

Date: Thu, 01 Jan 1970 00:00:00 GMT\r\n 

Connection: close\r\n 

Content-Type: text/html\r\n 

Content-Length: 32\r\n 

 

DDNS Configuration: 

enable=0 

ddnsaddr=ddns.meritlilin.com 

ddnsport=8098 

 

Chapter 3.14.2.  Set DDNS configurations 

Set DDNS configurations. 

Syntax: 

http://<serverIP>/ddns?cmd=set&<parameter>=<value> 

 

Parameters: 

 

Parameter Values Description 

enable=<int> 0,1 0: Disable, 1: Enable DDNS service 

Ddnsaddr=<string>  Omit default: 

“ddns.meritlilin.com” 

Specify the DDNS server IP address. You may 
use domain name. 

 

Example: 

http://192.168.0.200/ddns?cmd=set&ddnsaddr=ddns.dyndns.org 

Chapter 3.15.  PPPoE CGI 

Set PPPoE configurations. 

Syntax: 

http://<serverIP>/pppoe[?<parameter>=<value>[&<parameter>=<value>…]] 

 

Parameters: 

 

Parameter Values Description 

cmd=<string> Get/set 0: Disable, 1: Enable DDNS service 

pppoeaccount=<string>   Specify the PPPoE account string 

Pppoepassword=<string>  Specify the PPPoE acount password 

 

Chapter 3.16.  IR Cut 

Enable IR or disable IR LEDs. 

http://192.168.0.200/ddns?cmd=set&ddnsaddr=ddns.dyndns.org
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Syntax: 

http://<serverIP>/ir=<status> 

 

Example: 

http://192.168.0.200/ir=off 

Parameters: 

 

Parameter Values Description 

Status on / off / auto  

 

Chapter 3.17. Serial port transmission  

This section describes the serial port data transmission including sending and receiving actions.  

 

Syntax:  

 

http://<serverIP>/serial[?<parameter>=<value>[&<parameter>=<value>…]] 

 

Parameters:  

Parameter Values Description 

port=<int> 

write=<string> 

 

 

1,2 

Hex string of ASCII code, e.g. 

 

 

The COM port is selected with this parameter. 

write=414243 as “ABC”, The string going to send 

through RS232/485 port.  

 

 

Example:  

Send string “Hello” to com2.  

  

 http://192.168.0.200/serial?port=2&write=48656c6c6f  

 

http://192.168.0.200/
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Chapter 4.  H.264 Streaming 

Chapter 4.1.1.  Testing and verifying H.264 AVC video for your application 

VideoLAN media player, (VLC media player) can be used for testing and verifying Merit LILIN’s H.264 AVC 

IP cameras, video servers, or IP PTZ cameras before integrating Merit LILIN’s H.264 AVC video streaming 

into your product.   

 

Chapter 4.2.  H.264 and JPEG RTSP streaming 

To test streamings of H.264 and JPEG of NVT media stramings via RTP/RTSP/HTTP, you can verify the 

streamings by using QuickTime.   

 

To test RTP/RTSP/HTTP, please click on QuickTime->Edit->Preference.  Click on Transport 

Setup->Custom.  Change the protocol to HTTP and make sure port ID is 554. 
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After setting up above, please click on File->Open URL.  Please type the following URLs: 

 

Chapter 4.2.1. RTSP session description protocol (SDP) 

2MP, iMEGAPRO and L series & 2MP PTZ, IPS420 & IPS520 

Transport Protocol: HTTP 

 

   rtsp://192.168.0.200/rtsph2641080p 

rtsp://192.168.0.200/rtsph264480p 

 

   rtsp://192.168.0.200/rtspjpeg480p 

   rtsp://192.168.0.200/rtspjpegcif 

 

 

Transport Protocol: RTSP/TCP 

 

   rtsp://192.168.0.200:554/rtsph2641080p 

rtsp://192.168.0.200:554/rtsph264480p 

 

   rtsp://192.168.0.200:554/rtspjpeg480p 

   rtsp://192.168.0.200:554/rtspjpegcif 

 

Transport Protocol: UDP 

 

   rtsp://192.168.0.200:554/rtsph2641080p 

rtsp://192.168.0.200:554/rtsph264480p 

 

   rtsp://192.168.0.200:554/rtspjpeg480p 

   rtsp://192.168.0.200:554/rtspjpegcif 

 

5MP, iMEGAPRO, IPG1052 

   rtsp://192.168.0.200/rtsph2645m 

rtsp://192.168.0.200/rtsph264480p 

 

3MP, iMEGAPRO, IPG1032 

   rtsp://192.168.0.200/rtsph2643m 

rtsp://192.168.0.200/rtsph264480p 

 

4K, UHG1182 

   rtsp://192.168.0.200/rtsph2644k 

rtsp://192.168.0.200/rtsph264480p 

 

    1.3MP, PTZ, IPS622 and IPS722 

   rtsp://192.168.0.200/rtsph264sxga 

rtsp://192.168.0.200/rtsph264480p 

 

    960H, Video Server, VS212 

   rtsp://192.168.0.200/rtsph960h 
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Verify Multicast Streaming 

Force VLC to multicast streaming via Tools->Preference->Demuxers->RTP/RTSP/SDP 

demuxer->Force multicast RTP via RTSP. 

 

 

Open the Streaming based on the RTSP string. 
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Verify the Multicast Stream via Wireshark 

 

 
Chapter 4.3 Audio 

Chapter 4.3.1 Audio output (IP Camera to PC) 

Transport Protocol: HTTP 

 

IP cameras to PC (G.711 audio) 

 

Audio coding type: G.711 

Audio sample rate: 8KHz 

Audio bitrate: 64kbps 

 

  rtsp://192.168.0.200/rtspaudio 

 

Chapter 4.3.2 HTTP audio input (PC to IP camera) 

Transport Protocol: HTTP 

 

Audio coding type: PCM 

Audio sample rate: 8kKHz 

Audio bitrate: 16kbps 

 

  http://192.168.0.200/sendaudio 

 

 

http://192.168.0.200/sendaudio

